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USB 2.0 gegevensoverdracht op hoge snelheid

SRS WOW-surround-geluid
● De 3D surround-functie (SRS) verleent het geluid extra diepte.

1.8-inch TFT Kleuren-LCD
● U kunt genieten van hoge-kwaliteits afbeeldings- en videobestanden.

Ondersteuning van Diverse Spellen 
● U kunt genieten van diverse spellen zoals Tetris, Omok en Othello.

Ingebouwde Oplaadbare Li-Ion Batterij
● De ingebouwde, oplaadbare lithiumbatterij biedt een afspeeltijd tot 25 uur voor

muziekbestanden en 5 uur en 30 minuten voor videobestanden. (Volgens bedrijfsmetingen)

Regelfunctie terugspeelsnelheid
● U kunt de terugspeelsnelheid voor muziek- of stemopnamebestanden aanpassen.

Opwaardeerbaar
● Als het nodig is, kun je de ingebouwde programma's opwaarderen. 

Kijk op onze introductiepagina (www.samsung.com) voor upgrades.

Functies
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Vaste schijf voor massaopslag
● U kunt de ingebouwde harde schijf gebruiken voor het opslaan van uw hele

muziekbibliotheek en deze tevens als extern station op uw pc gebruiken
voor het opslaan van andere gegevensbestanden.

MP3-, WMA-, Audio ASF- en Ogg-bestanden afspelen
● Uw speler ondersteunt het afspelen van zowel MP3, WMA, Audio ASF als Ogg.

Ondersteuning USB-Hostfunctie
● Sluit externe apparaten aan, zoals digitale camera’s, MP3-afspeelapparatuur, etc.

om geluidsbestanden en afbeeldingsbestanden te kunnen overbrengen zonder
behulp van een pc.

Video-terugspeelfunctie
● U kunt na het downloaden videobestanden bekijken Door gebruik te maken

van de Multimedia Studio.

Afbeeldings- & Tekstviewerfunctie
● U kunt JPEG-bestanden en tekstbestanden (.txt) bekijken.

Direct opnemen van MP3's  
● U kunt muziek van CD’s, muziekcassettes en radio coderen naar MP3 bestanden.
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Volg de veiligheidsinstructies op voor in het verkeer
● Gebruik de oortelefoon niet terwijl u een auto bestuurt of op een fiets rijdt. 

Dit is niet alleen gevaarlijk, maar ook in strijd met de wet. 
● Er kan een ongeluk gebeuren als u het volume van de oortelefoon harder zet terwijl u op straat loopt, 

met name als u de weg oversteekt op kruispunten. 

Bescherm uw oren 
● Zet het volume niet te hard. Artsen waarschuwen tegen de gevolgen van langdurige blootstelling aan harde

muziek.  
● Stop met het gebruiken van het apparaat of zet het volume lager als uw oren beginnen te tuiten.

● Zorg dat de oortelefoonkabel niet met uw arm of andere objecten verstrikt raakt als u wandelt of
sportoefeningen doet.

● Volg de plaatselijke voorschriften voor afvalverwijdering op bij het weggooien van verpakkingen, 
batterijen en oude elektronische apparaten.   

● De verpakking van uw speler bestaat uit karton, polyethyleen, enz. en bevat geen overbodige materialen. 

● Omgevingstemperatuur : 5°C ~ 35°C 
● Luchtvochtigheid : 10% ~ 75%

I Oortelefoon

I Gebruiksomstandigheden omgeving

I Milieu-informatie 

Veiligheidsinstructies
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Gelieve alle instructies door te nemen om te voorkomen dat u zichzelf verwondt en opdat geen
schade wordt toegebracht aan het apparaat.

✽ Houdt u er rekening mee dat wij elke aansprakelijkheid afwijzen voor schade door verlies van opgeslagen of
opgenomen gegevens ten gevolge van defecten, reparaties of andere oorzaken.

Zorg ervoor dat er geen
vreemde voorwerpen in
het apparaat terecht
komen.

Stel het apparaat niet
bloot aan chemicaliën
zoals benzeen of 
verdunningsmiddelen.

Oefen geen al te grote druk
uit op het apparaat.

Plaats geen zware
voorwerpen bovenop
het apparaat.

Raak de oplader niet met
natte handen aan.

Stel het apparaat niet
bloot aan direct zonlicht
of andere hittebronnen.

Bewaar het apparaat niet op
in een stoffige omgeving.

Gebruik het apparaat niet
in de buurt van een
apparaat dat een krachtig
magneetveld opwekt.

Probeer niet het apparaat
zelf uit elkaar te halen en
te repareren.

Niet blootstellen aan
extreme temperaturen
(tussen -5°C en Lager
dan +35°C). Niet bloot-
stellen aan vocht.
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Waarschuwingen bij het opladen

N
L

Bij uw speler is een lader meegeleverd.

Sluit de lader aan op een stopcontact.
✻ Wanneer het laden voltooid is verschijnt 

het bericht “Charge Completed” op het scherm.
✻ Om te laden opnieuw met behulp van de

USB-kabel, dient u [Settings] → [System] →
[PC Connect Mode] → [Charge] in het
menuscherm te selecteren. Om met behulp van
de USB-kabel te laden, moet de pc ingeschakeld
zijn. Indien de pc in de energiebesparingsmodus
overgaat, wordt de batterij niet geladen.

✻ Het laden van de batterij via de USB-kabel duurt ongeveer 6 uur. Het laden van de batterij met de lader
duurt ongeveer 4 uur.

LLLLeeeetttt   oooopppp
- Vermijd het risico van brand door de batterij niet langer dan 12 uur op te laden.
- Sluit niet meerdere apparaten aan op hetzelfde stopcontact.
- Gebruik geen defecte lader.
- Als u de oplaadbare batterij voor het eerst gebruikt of nadat u de batterij verschillende maanden

niet hebt gebruikt, moet u deze eerst volledig opladen.
- Als u de batterij te lang oplaadt, gaat dit ten koste van de levensduur van de batterij.
- De oplaadbare batterij is een verbruiksartikel en de capaciteit ervan neemt geleidelijk aan af.
- U kunt de levensduur van uw batterij verlengen door de volledig opgeladen batterij te gebruiken 

totdat deze volledig leeg is en de batterij vervolgens helemaal op te laden voordat u deze
opnieuw gaat gebruiken.

- Wees ervan bewust dat wij elke verantwoordelijkheid afwijzen voor schade, die het gevolg is
van verloren gegevensbestanden (bewaard of opgenomen) vanwege defecten, reparatie of
andere oorzaken.
Anders kan dit leiden tot brand of elektrische schokken.

- Raak de lader niet met natte handen aan.

✍

Veiligheid van de batterijlader
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!

!
WAARSCHUWING

KANS OP ELEKTRISCHE SCHOK.  NIET OPENMAKEN

De ongeïsoleerde onderdelen binnenin de
oplader kunnen een elektrische schok veroorzaken.
Maak de behuizing van de oplader niet open om uw
eigen veiligheid niet in gevaar te brengen. 

Lees deze gebruikershandleiding door om
mogelijke problemen te voorkomen bij het gebruik
van de oplader.

WWWWaaaaaaaarrrrsssscccchhhhuuuuwwwwiiiinnnngggg
- Om brand of een elektrische schok te voorkomen, mag u de lader niet in de buurt van water

gebruiken.

LLLLeeeetttt   oooopppp
- Gebruik de oplader alleen bij een stopcontact dat overeenkomt met de vorm van de stekker op

de omvormer om elektrische schokken te voorkomen.
- Zorg ervoor dat de stekker van de oplader volledig in het stopcontact zit.  

✍

✍
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Positie van de bedieningselementen
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Herhaling/Opn
ame-knop

BLOKKEERSC
HAKELAAR

MENU KNOP

Display

Aansluiting voor oortelefoon

TOOL-KNOP

[Achterkant]
RESET-

OPENING

Aan/uit-knop
Afspeel- / pauzeknop

Knop voor springen/
zoeken

Selectie/Navigatie/
Volumeregeling-knop

Knop voor springen/
zoeken

Aansluiting voor USB-kabel

LINE IN-aansluiting
Microfoon

OOppmmeerrkk iinngg
- Reset de speler door de RESET-opening in te drukken met behulp van een gepunt voorwerp

zoals een veiligheidsspeld.

✍

Onderdelen
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● De capaciteit van het bruikbare interne geheugen is minder dan aangegeven omdat de interne
firmware eveneens een deel van het geheugen gebruikt.

● Het ontwerp van accessoires kan zonder kennisgeving worden gewijzigd om verbeteringen aan
te brengen.

Speler Oortelefoon Line In-kabel

Gebruikershan
dleiding

lader

USB-kabel

USB-host Adapter Installatie-CD Dockingstation

Model

Intern geheugen

YH-J70 SB/SW

20GB

YH-J70 LB/LW

30GB

❊ De Dockingstation en de draagtas worden alleen geleverd bij modellen van 30 GB.

Draagtas
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Display
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Indicateur Spelen/Pauze

Geluidssterkte-indicator

Indicateur Spelduur

Indicator voor afspeelmodus
EQ/SRS controlelampje

Indicator voor resterend 
batterijvermogen

Weergave muzieknummer

Actueel Tracktitel

Indicateur Voortgang

OOppmmeerrkk iinngg
- De schermafbeeldingen zijn slechts ter illustratie. Het werkelijke scherm kan afwijken.

✍

Positie van de bedieningselementen
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Voorkant Achterkant

LINE OUT-aansluitingAansluiting voor USB-kabel

I Dockingstation

OOppmmeerrkk iinngg
- U kunt muziek beluisteren door de speler in de houder te plaatsen en de oortelefoons of luidsprekers

via de LINE OUT-uitgang aan te sluiten.
- U kunt de USB-hostfunctie niet gebruiken indien u de houder gebruikt. U kunt deze functie eveneens

niet gebruiken indien u de USB-hostadapter hebt aangesloten.

✍

❊ De Dockingstation en de draagtas worden alleen geleverd bij
modellen van 30 GB.
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Verbinding met de computer
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Verbinding met de computer

14

Installeer Samsung Media Studio, voordat u de speler
aan de pc aansluit.

❑ Systeemvereisten
Uw pc moet aan de volgende
vereisten voldoen:

● Pentium 200MHz of hoger
● Windows XP
● 50MB vrije ruimte op de harde

schijf
● Cd-rom-station 

(dubbele snelheid of meer)
● Ondersteunde USB-poort (2.0)
● DirectX 9.0 of hoger.

OOppmmeerrkk iinngg
- Log in op uw pc als administrator

(hoofdgebruiker) en installeer de
bijgeleverde software
(Media/Multimedia Studio)
voor Windows XP. 
U kunt de accountinformatie wijzigen
door [Start] → [Control Panel] →
[User Account] te selecteren in de
taakbalk op uw pc. 

I Software installeren

1 Plaats de installatie-cd in het cd-rom-station. 
De volgende afbeelding wordt weergegeven. 
Selecteer [Install Samsung Media Studio].

✍

2 Volg de instructies in het venster om de installatie te voltooien.
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Verbinding met de computer
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Hoe u kunt controleren of het USB-stuurprogramma op de juiste 
wijze is geïnstalleerd
Windows XP: 

Control Panel → System → Hardware → Device Manager → Disk Drives →
Samsung YH-J70 USB Device

5 Als het USB-stuurprogramma niet automatisch wordt geïnstalleerd, raadpleegt u de
volgende pagina.

Verbinding met de computer

16

1 Sluit de USB-kabel aan op de USB-poort van de computer.

2 Sluit het andere uiteinde van de USB-kabel aan op de USB-poort aan de onderkant
van de speler.
● Als u de USB-kabel loskoppelt van uw pc terwijl een opdracht wordt uitgevoerd of terwijl het

USB-stuurprogramma wordt geïnstalleerd, werkt uw pc mogelijk niet correct.

4 Bij installatie van het USB-stuurprogramma wordt "Samsung YH-J70 USB
Device" weergegeven onder [Device Manager].

3 Het USB-stuurprogramma wordt geïnstalleerd en er wordt een bericht weergegeven
dat er wordt gezocht naar een nieuw apparaat. Mogelijk is het scherm van de dis-
play leeg tijdens de installatie. Ga naar Apparaatbeheer om te controleren of de
installatie met succes is voltooid.

I De speler aansluiten op de pc via de USB-kabel

PC PC

USB-kabel USB-kabel

Speler

Speler

Dockingstation

OOppmmeerrkk iinngg
- Indien u gebruik maakt van de oplaadbare houder, dient u de USB-kabel aan de verbindingspoort

voor de USB-kabel op de houder aan te sluiten.

✍
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De speler als Verwisselbare Schijf gebruiken
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I De USB-kabel loskoppelen
Nadat het verzenden van alle de bestanden voltooid is, dient u de kabel op de
volgende manier uit te schakkelen:

1 Dubbelklik op de groene pijl op de taakbalk
in de rechterbenedenhoek van het venster.

2 Selecteer het USB-apparaat en klik op de [Stop] knop. Wanneer u [Stop
a Hardware device] (stop een hardware-apparaat) op het scherm ziet
verschijnen, klikt u op de [OK] knop en koppelt u de USB-kabel los. 

LLeett   oopp
- Als u de USB-kabel op een onjuiste manier loskoppelt, kunnen de bestanden in het appa-

raat beschadigd raken waardoor ze niet kunnen worden afgespeeld.

✍

De speler als Verwisselbare Schijf gebruiken
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U moet de modus ‘PC connection’ selecteren, voordat u de verwijderbare schijf kunt gebruiken.
Druk op de MENU-knop en selecteer [Settings] → [PC Connect Mode] → [Removable Disk] uit het menu.

I Bestanden downloaden
1 Sluit de speler aan op uw PC.

2 Klik met de rechtermuisknop op de START knop en selecteer daarna ‘Verkenner’
om de ‘Windows Verkenner’ op de PC te openen.
● Verwisselbare schijf wordt weergegeven in Windows Verkenner.

3 Selecteer het bestand dat u wilt opslaan en sleep het naar de gewenste bestandsmap.
● Sleep en druppeel de muziekbestanden naar de MUSIC bestandsmap, tekstbestanden naar

de TEXT bestandsmap, afbeeldingsbestanden naar de PHOTO bestandsmap, SVI-bestanden
naar de VIDEO bestandsmap en gegevensbestanden naar de DATA bestandsmap.
- De DATA bestandsmap wordt niet op de speler vertonen.

● De speler ondersteunt alleen videobestanden met de extensie .svi. Om andere soorten
videobestanden te kunnen bekijken dient u deze bestanden eerst met Multimedia Studio
te converteren, waarna u deze omgezette bestanden naar de speler verzendt.

LLeett   oopp
- Als u de USB-kabel tijdens het downloaden of uploaden van een bestand uitschakkelt, kan dit

leiden tot storingen in de speler.
- De volgorde waarin muziekbestanden worden weergegeven in Windows Verkenner kan afwijken

van de afspeelvolgorde in de speler.

✍
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Media Studio gebruiken
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3 Wanneer de muziekbestanden verschijnen, selecteert u de bestanden die u wilt
verzenden, waarna u op de [Transfer] knop drukt.

●  De geselecteerde bestanden worden nu naar de speler gezonden.
●  Selecteer [Device] → [Reconstruct Library] van Media Studio, indien bestanden

zijn gedownload met behulp van een verwijderbare schijf.
Muziekbestanden worden automatisch classificiert in bestandsmappen voor
Artiest, Album, Genre en Track in overeenstemming met de tag-informatie.
De bestandsmappen Artiest, Album, Genre en Track kunnen als volgt worden
gevonden door [Settings] → [Navigation] → [Music Library] te selecteren.

OOppmmeerrkk iinngg
- U wordt verwezen naar de [Help] functie voor meer gedetailleerde informatie.
- Wat is een ID3-tag?

Dat zijn gegevens die aan een MP3 wordt verbinden en informatie bevatten die relevant zijn
voor het bestand, zoals titel, artiest, album, jaar en genre. Er is ook ruimte voor opmerkingen in
een ID3-tag.

✍

Media Studio gebruiken
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● Media Studio is het programma waarbij u muziekbestanden kunt downloaden naar de speler
en muziekbestanden kunt afspelen op de PC.

● Klik vanaf uw bureaublad op het ‘Media Studio’ pictogram.

Library-
venster

(=Bibliotheek)

(Apparaat-)
verbindingsvenster

I Bestanden downloaden

1 Sluit de speler aan op uw PC.
● Er zal nu aan de rechterzijde van het beeldscherm een verbindingsvenster 

verschijnen.
Indien het scherm ‘Device Connection’ niet automatisch verschijnt, selecteer
[Device] → [Show device Window] uit het hoofdmenu.

2 Selecteer de bestandsmap waarin zich de bestanden bevinden die u wilt 
overbrengen vanuit het [Library] venster.
● De muziekbestanden in de bestandsmap verschijnen in het midden van het

scherm.
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Media Studio gebruiken
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OOppmmeerrkk iinngg
- Een nieuwe Afspeellijst wordt aangemaakt wanneer u op de [Add] knop in het

Afspeellijst-venster drukt.
Een geselecteerde Afspeellijst wordt gewist als op de [Delete] knop wordt gedrukt.

- U wordt verwezen naar de [Help] functie voor meer gedetailleerde informatie.

4 Sleep de gewenste bestanden naar de 
gecreëerde Afspeellijst.

5 Druk op de [Transmit] knop in het
Afspeellijst-venster nadat u de Afspeellijst
heeft geselecteerd.
● Bestanden in de Afspeellijst worden nu 

naar de speler verzonden.
● Schakkel de speler van de pc uit en

druk op de MENU-knop op de speler.
Selecteer vervolgens [Navigation] →
[Playlist] → [PC Playlist] om de
verzonden speellijst te bekijken.

✍

Media Studio gebruiken
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I Afspeellijst verzenden

1 Sluit de speler aan op de PC.

2 Klik op [File] → [Add Playlist] aan de bovenzijde van het beeldscherm.
● Als het invoerscherm verschijnt, voer dan de naam van de Afspeellijst-

bestandsmap in.

3 Selecteer de folder waarin zich de bestanden bevinden die u wilt verzenden vanuit
het [Library] venster.
● De muziekbestanden in deze bestandsmap verschijnen in het midden van het

beeldscherm.
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Media Studio gebruiken
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1 Plaats uw CD met de te splitsen tracks in de CD-ROMspeler van uw PC.

2 Druk op de [Search Audio CD] knop in het lager gelegen gedeelte van het scherm.
● De tracks op de CD worden nu weergegeven.

3 Selecteer de te splitsen nummers en druk op de [Rip a CD] knop.
● Het geselecteerde nummer wordt nu geconverteerd naar een MP3-bestand.
● Selecteer [Tools] → [Audio Source Format Conversion Settings] aan de bovenzijde

van het beeldscherm om de splits-instellingen te veranderen.

I Tracks van een Audio CD splitsen

OOppmmeerrkk iinngg
- U wordt verwezen naar de [Help] functie voor meer gedetailleerde informatie.

Wijzig 
bestandsopmaak

Bewaar pad

✍

Media Studio gebruiken
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1 Sluit de speler aan op de PC.

2 Druk op [Device] → [Format] aan de bovenkant van het beeldscherm.

3 Druk op de [Start] knop als het Format-venster verschijnt.
● Het geheugen van de speler wordt nu geformatteerd en alle opgeslagen

bestanden zullen worden gewist. 

I De Speler Formatteren

OOppmmeerrkk iinngg
- U wordt verwezen naar de [Help] functie voor meer gedetailleerde informatie.
- Indien u de speler op uw pc hebt geformatteerd, formatteer hem dan nog eens met behulp van

Media Studio.

✍

● Bij formattering worden alle bestanden van de MP3-speler verwijderd, zodat een maximale
geheugencapaciteit beschikbaar is voor de opslag van nieuwe bestanden. 
U kunt zich de moeite van het één voor één verwijderen van ongewenste bestanden besparen
door alle bestanden tegelijk weg te gooien.
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Media Studio gebruiken
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1 Sluit de speler aan op de PC.

2 Druk op de [Delete] knop aan de onderzijde van het verbindingsvenster
nadat u in het verbindingsvenster de gewenste bestanden of bestandsmappen
heeft geselecteerd.
● Een geselecteerde bestandsmap of geselecteerd bestand wordt gewist.

I Een bestand/map verwijderen

OOppmmeerrkk iinngg
- U wordt verwezen naar de [Help] functie voor meer gedetailleerde informatie.

✍

Media Studio gebruiken
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1 Sluit de speler aan op de PC.

2 Druk op de [Create Folder] knop aan de onderkant van het verbindingsvenster.

3 Wanneer een invoerscherm verschijnt voert u de naam in van de nieuwe bestandsmap.
● Een nieuwe bestandsmap wordt aangemaakt.
● Wanneer u een nieuwe bestandsmap opent en vervolgens een bestand verzendt,

dan wordt dit bestand geplaatst in de zojuist aangemaakte bestandsmap.

I Een bestandsmap aanmaken

OOppmmeerrkk iinngg
- U wordt verwezen naar de [Help] functie voor meer gedetailleerde informatie.

✍
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● Multimedia Studio is een programma dat het bewerken van afbeeldingen, het afspelen van
video's, het omzetten van bestandsindelingen en het maken van multimedia-albums ondersteunt.

I Software installeren
1 Plaats de installatie-cd in het cd-rom-station. 

Selecteer [Install Multimedia Studio].

2 Selecteer uw taal.

Vervolg…

Media Studio gebruiken
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I De Help-functie bekijken in Media Studio
Activeer Media Studio en druk vervolgens op F1.
● Het scherm ‘Help’ verschijnt.

Klik op [Help] aan de bovenzijde van het beeldscherm.
● Klik op Help om het Help-venster weer te geven.

OOppmmeerrkk iinngg
- De muziekherkenningstechnologie en bijbehorende gegevens worden geleverd door

Gracenote en Gracenote CDDB® Music Recognition ServiceSM. 
- CDDB is een gedeponeerd handelsmerk van Gracenote. Het Gracenote-logo en 

-logotype, het Gracenote CDDB-logo en –logotype, en het logo "Powered by Gracenote
CDDB" zijn handelsmerken van Gracenote. Music Recognition Service en MRS zijn 
servicemerken van Gracenote.

✍
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● Voer Multimedia Studio uit vanaf het bureaublad.

I Afbeeldingen bewerken
1 Selecteer de map met afbeeldingen die u wilt 

verwerken uit het mappenvenster aan de 
linkerbovenkant van Multimedia Studio.
● De opgeslagen bestanden worden weergegeven 

in het venster met de bestandslijst aan de 
rechterkant.

2 Selecteer de afbeelding die u wilt bewerken.
● De geselecteerde afbeelding wordt weergegeven 

in het venster [Preview image].

3 Klik op de knop [Edit Img].
● Vanuit het venster [Picture editor] kunt u verschillende functies uitvoeren, zoals het 

bewerken van achtergrondafbeeldingen, het bewerken van lagen, het invoegen van 
illustraties, het maken van kaders en het uitvoeren van andere bewerkingsfuncties.

OOppmmeerrkk iinngg
- Raadpleeg de [Help] voor meer informatie.

✍

Multimedia Studio installeren

30

3 Volg de instructies in het venster om de installatie te voltooien.
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6 Stel het formaat en het pad van de afbeelding in in het venster 
[Resize images] en klik vervolgens op de knop [OK].
● De afbeelding wordt nu naar het geselecteerde apparaat verzonden.

● De verzonden afbeelding kan worden bekeken bij [Photo/Video] → [Photo].

● Het optimale afbeeldingsformaat voor weergave op het apparaat is 160x 128.
Stel het afbeeldingsformaat bij als de afbeelding niet correct wordt weergegeven op
de speler.

OOppmmeerrkk iinngg
- Het pad geeft de locatie of map aan waarnaar de omgezette afbeeldingen worden opgeslagen op

de pc.
- Afbeeldingsbestanden die zijn opgeslagen in de speler kunnen worden verwijderd door middel van

[File] → [Delete images from device].

- Raadpleeg de [Help] voor meer informatie.

✍

Multimedia Studio gebruiken
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I Afbeeldingen verzenden
1 Sluit de speler aan op de pc.

2 Selecteer de afbeelding(en) die u wilt verzenden naar de speler.

3 Selecteer [File] → [Export images to device] aan de bovenzijde van het scherm
‘Multimedia Studio’.

4 Selecteer het apparaat dat is aangesloten op de pc vanaf het scherm [Select
device] en klik vervolgens op de knop [OK].

5 Selecteer de bestandsmap die zal bewaard worden van het scherm
‘folder selection’en druk vervolgens op de [OK]-knop.

Selecteer de modus ‘PC connection’, voordat u afbeeldingsbestanden of
videobestanden via Multimedia Studio verzendt. Druk op de MENU-knop en
selecteer [Settings] → [PC Connect Mode] → [Removable Disk] uit het menu.
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5 Selecteer in het mapselectievenster de bestandsmap waarnaar u het bestand wilt
verzenden en druk vervolgens op de [OK] knop.

6 Druk op de [Convert] knop wanneer het conversievenster verschijnt.
● Het geconverteerde bestand wordt in de svi bestandsopmaak verzonden.
● Het verzonden videobestand kan bekeken worden op [Photo/Video] → [Video].

▲ Voor het converteren en verzenden van een videobestand dient u het volgende te 
controleren.
1. Controleer of ‘Direct X 9.0’ of een meer recente versie op uw PC is geïnstalleerd.
2. Controleer of Windows Media Player 9.0 of een meer recentere versie op uw PC is geïnstalleerd.
3. Controleer of ‘Unified Codec Pack’ op uw PC is geïnstalleerd.

OOppmmeerrkk iinngg
- Videobestanden die op de speler bewaarden zijn, kunnen geschrapt worden door [File] →

[Delete videos from device] te selecteren..
- U wordt verwezen naar de [Help] functie voor meer gedetailleerde informatie.

✍

Multimedia Studio gebruiken
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I Video’s verzenden

1 Sluit de speler aan op uw PC.

2 Selecteer de video’s die u naar de speler wilt verzenden.

3 Selecteer [File] → [Export videos to device] aan de bovenzijde van Multimedia Studio.

4 Selecteer het met de PC verbonden apparaat vanaf het [Select device] venster, 
en druk vervolgens op de [OK] knop.

Selecteer de modus ‘PC connection’, voordat u afbeeldingsbestanden of
videobestanden via Multimedia Studio verzendt. Druk op de MENU-knop en
selecteer [Settings] → [PC Connect Mode] → [Removable Disk] uit het menu.
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3 Klik op de knop     [Capture] en klik vervolgens op 
de knop     [Capture] als de afbeelding wordt 
weergegeven die u wilt vastleggen.
● De geselecteerde afbeelding wordt vastgelegd.

4 Klik op de knop [Save].
● Save this captured image : hiermee slaat u de huidige

geselecteerde afbeelding op.
● Save all captured images : hiermee slaat u alle 

vastgelegde afbeeldingen op.

1

2

2

1

Vervolg…

Multimedia Studio gebruiken
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I Videobeelden vastleggen

1 Druk op de knop [Capture] boven aan het 
menu van Multimedia Studio.
● Het scherm Media Player wordt weergegeven.

2 Klik op [Menu] → [Open] op de pc en selecteer de video die u wilt afspelen.
● De geselecteerde video wordt afgespeeld.
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Multimedia Studio gebruiken

I De Help bekijken in Multimedia Studio
Voer Multimedia Studio uit en klik op de knop Help boven aan het scherm.

● Help wordt weergegeven.

Multimedia Studio gebruiken
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5 Selecteer de map waarin u de afbeeldingen wilt opslaan in het venster [Save As] en
klik op de knop [Save].
● De geselecteerde afbeelding wordt opgeslagen.

OOppmmeerrkk iinngg
- Codecs voor het afspelen en omzetten van videobeelden worden niet meegeleverd. 

U wordt geadviseerd de meest recente versies van codecs te gebruiken.
- Raadpleeg de [Help] voor nadere informatie.

✍
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I Beginpunt
Druk tijdens het afspelen van muziekbestanden op
de knop A↔B aan het begin van de herhalingslus
die u wilt instellen.
● De aanduiding A↔ wordt weergegeven op het display.

Druk kort op de knop A↔B op het punt dat u de
herhalingslus wilt beëindigen.
● De aanduiding A↔B wordt weergegeven op het display.
● De lus wordt telkens opnieuw afgespeeld.  

Druk kort op de A↔B knop om de herhalingslus te
annuleren.

I Eindpunt

Continue herhaling

Gebruik de blokkeerfunctie om alle knoppen te vergrendelen en uit te schakelen. 

Hold-functie van het hoofdtoestel

Activeer op de systeemeenheid.

❈ Alle knoppen op het hoofdtoestel zullen inactief worden gemaakt. Nu kunnen alleen de knoppen
van de afstandsbediening worden gebruikt voor de invoer.

❈ Als u de blokkeerschakelaar (HOLD) activeert, wordt een " " weergegeven op het display.

Muziekbestanden Afspelen
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I Muziek afspelen

I Muziek tijdelijk onderbreken

● Inschakelen : Druk op de knop √» om het apparaat in te schakelen.
● Uitschakelen : Druk op de knop √» en houd deze ingedrukt om het apparaat uit te schakelen.

Druk op de knop √» en houd vast
● Het afspelen wordt automatisch gestart.

Druk op de knop √» om het afspelen tijdelijk te
onderbreken.
● Druk, terwijl de pauzestand actief is, kort nogmaals

op √» om het afspelen te hervatten.

Zorg ervoor dat de speler volledig is opgeladen en dat de oortelefoon is aangesloten.

Regel het volume door de SELECT-knop op en neer of op te bewegen.
● Het volume kan worden regelt in intervallen van 00 (MIN) tot 60 (MAX).

I Het volume regelen
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● U kunt navigeren en selecteren met behulp van de SELECT-knop.
● Druk op de knop om naar het vorige scherm te gaan.

1 Druk in de muziekmodus op de TOOL-knop.
● Het scherm ‘Music Tool’ verschijnt.

2 Ga naar [Add to Favorites] en druk op de
SELECT-knop.

3 Bewaar de lijst en druk op de SELECT-knop.
● Het geselecteerde bestand wordt aan de lijst toegevoegd.
● Er kunnen 10 speellijsten worden geselecteerd.
● Toegevoegde bestanden kunnen gevonden worden in [Navigation] → [Playlist] →

[Favorites].

1 Druk in de muziekmodus op de TOOL-knop.
● Het scherm ‘Music Tool’ verschijnt.

2 Ga naar [EQ] en druk op de SELECT-knop.

3 Selecteer het gewenste geluidseffect en druk
op de SELECT-knop.
● Normal → Jazz → Classic → Pop → Rock → Bass Boost → Bass Cut → R&B → Club →

Dance → House → High Boost → High Cut Loud → Ballad → Strings → Vintage →
Vocal Boost → Bluesy → User EQ

● Wanneer u ‘User EQ’ gebruikt, kan de gewenste geluidseffect ingesteld worden via
[Settings] → [Sound Effect] → [User EQ Set].

I EQ

I Add to Favorites

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

List 2

List 3

List 4

List 5

List 1

Jazz

Classic

Pop

Rock

Normal

Zoeken naar muziek-/spraakbestanden
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OOppmmeerrkk iinngg
- VBR(Variable Bit Rate)-bestand: een bestand waarvoor constant de bestandscompressiewaarde

wordt gewijzigd overeenkomstig het type geluid dat deel uitmaakt van het bestand, zoals de
toonhoogte.

- Wanneer u een VBR-bestand speelt, kunt u niet naar de vorige track teruggaan en deze spelen,
zelfs niet indien in geen 5 seconden nadat de track begint te spelen de knop indrukt.

- Bestanden die zijn gedownload in MP2 of MP1 bestandsopmaak en waarvan de bestandsextentie
is gewijzigd in .mp3 kunnen mogelijk niet afgespeeld worden. 

● Houd de , knop tijdens het afspelen ingedrukt om naar een gedeelte te zoeken waarnaar
u wilt luisteren.  

● Laat de knop weer los om normaal afspelen te hervatten.

I Zoeken naar specifieke gedeelten tijdens het afspelen

● Druk tijdens het afspelen kort op de knop om de volgende track af te spelen. 
● Wanneer u binnen 5 seconden nadat het afspelen is gestart kort op de knop

drukt, zal naar de vorige track worden gesprongen en wordt deze
vervolgens afgespeeld. Als u na 5 seconden kort op de knop drukt, wordt de
huidige track vanaf het begin afgespeeld.

I Zoeken naar een specifiek bestand tijdens het afspelen

● Druk op de knop , in de ‘stop/pause’-modus om naar de vorige/volgende track te
gaan.

I Tracks wijzigen in de stopmodus

✍
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1 Druk in de muziekmodus op de TOOL-knop.
● Het scherm ‘Music Tool’ verschijnt.

2 Ga naar [Play Mode] en druk op de SELECT-knop.

3 Selecteer de gewenste speelmodus en druk op de
SELECT-knop.
● Normal : Alle bestanden eenmaal op volgorde spelen.
● Repeat: Ga naar [Repeat] en druk op de SELECT-knop.

- One : Eén bestand herhalen.
- Folder : De actueel bestandsmap herhalen.
- All : Alle bestanden herhalen.

● Shuffle : Ga naar [Shuffle] en druk op de SELECT-knop.
- Folder : De bestanden in de bestandsmap willekeurig spelen.
- All : De bestanden willekeurig spelen.

I Play Mode

1 Druk op de TOOL-knop, wanneer de
muziek speelt of is gestopt.
● Het scherm ‘Music Tool’ verschijnt.

2 Ga naar [File Info] en druk op de
SELECT-knop.
● De informatie van het actueel spelende of

gepauzeerde bestand wordt vertonen.

I File Info.

Blue Tijd

Artiest

Album

Genres

Bestandsgrootte

Sky

Best

Dance

7782656 bytes

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

Repeat

Shuffle

Normal

De belangrijkste functies instellen in de muziekmodus
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1 Druk in de muziekmodus op de TOOL-knop.
● Het scherm ‘Music Tool’ verschijnt.

2 Ga naar [SRS] en druk op de SELECT-knop.

3 Selecteer de gewenste SRS-modus en druk op
de SELECT-knop.
● Normal → SRS → TruBass →  WOW →  HD
● SRS : U hoort nu 3D-stereogeluid.
● TruBass : Dit is een functie voor het versterken van de bas, waardoor een voller geluid

mogelijk wordt.
● WOW : Deze functie biedt u de mogelijkheid tegelijkertijd de functies SRS en Trubass

te gebruiken.
● HD : U kunt genieten van heldere stemhebbende en hoge tonen.

Add to Favorites

TOOL

EQ

SRS

Play Mode

File Info.

SRS

TruBass

WOW

HD

Normal

I SRS

OOppmmeerrkk iinngg
- is een handelsmerk van SRS Labs, Inc.

WOW technologie is geinkorporeerd met verlof van de licentiehouder SRS Labs, Inc.
- Stel het volume in op een geschikt niveau, aangezien het volume hoger kan worden als de

functie SRS is ingeschakeld.
- Dit apparaat ondersteunt samplingfrequenties van 32KHz, 44.1KHz of 48KHz.

✍
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Druk op de knop MENU.
Selecteer FM Radio in het menu en druk vervolgens op de knop SELECT.

I De FM-Radiomodus inschakelen

● Handmatig zoeken : Druk op de knoppen , om de golflengte te verhogen of te
verlagen.

● Automatisch zoeken : Houd de knoppen , ingedrukt om automatisch te zoeken
naar te ontvangen zenders.

I Naar een golflengte zoeken 

MENU-opties

46

01 I Music 02 I FM Radio 03 I Navigation 04 I Text

05 I Photo/Video 06 I USB Host 07 I Games 08 I Settings

● Now playing : hiermee geeft u het nummer weer dat op dat moment wordt afgespeeld. 
● FM Radio : hiermee luistert u naar de FM-radio. 
● Navigation : Ga naar de navigatiemodus en rondneuzer door bestanden en

bestandsmappen.
● Text  : hiermee leest u tekstbestanden.
● Photo/Video : Bekijk bewaarde afbeeldingsbestanden of video’s
● USB Host : hiermee brengt u bestanden die zijn opgeslagen in het apparaat over naar

externe apparaten of brengt u bestanden op externe apparaten over naar
het apparaat.

● Games : Speel een spel.
● Settings : Stel de functies in.

Druk op de knop MENU om naar de MENU-modus over te schakelen.
Gebruik de SELECT-knop om het menu-item dat u wenst, te selecteren en druk vervolgens kort
op de SELECT-knop.

OOppmmeerrkk iinngg

- Druk in de menumodus op de knop om naar het vorige scherm te gaan.

✍
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● U kunt de FM-frequenties handmatig voorinstellen.
● U kunt tot 30 frequenties bewaren.

1 Druk in de FM-modus op de TOOL-knop.
● Het scherm ‘FM Tool’ verschijnt.

2 Ga naar [Edit Preset] en druk op de SELECT-knop.

3 Ga naar [Save] of [Delete] en druk op de SELECT-knop.
● Save : Selecteer het gewenste vooringestelde nummer

met behulp van de SELECT-knop. De actueel frequentie
wordt bewaard.

● Delete : Selecteer een bewaard vooringesteld nummer
om te verwijderen. Het geselecteerde vooringestelde
nummer zal geschrapt worden.

I Edit Preset

1 Druk in de FM-modus op de TOOL-knop.
● Het scherm ‘FM Tool’ verschijnt.

2 Ga naar [Auto Preset] en druk op de SELECT-knop.
● Er kunnen tot 30 frequenties automatisch worden bewaard.

I Auto Preset

Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset
Delete

Save

Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset

Preset Memory

CH 01: 87.75

CH 02: 91.90

CH 03: 95.90

CH 04: 103.50

CH 05: 107.70

De hoofdfuncties in de FM-modus instellen
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1 Druk in de FM-modus op de TOOL-knop.
● Het scherm ‘FM Tool’ verschijnt.

2 Ga naar [Mono/Stereo] en druk op de
SELECT-knop.

3 Selecteer de gewenste FM-modus en druk op
de SELECT-knop.

Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset

Stereo

Mono

I Mono / Stereo

● U kunt navigeren en selecteren met behulp van de SELECT-knop.
● Druk op de knop om naar het vorige scherm te gaan.

OOppmmeerrkk iinngg
- Mono wordt automatisch geselecteerd in gebieden met een

zwakke FM-ontvangst.

1 Druk in de FM-modus op de TOOL-knop.
● Het scherm ‘FM Tool’ verschijnt.

2 Ga naar [Preset Mode] en druk op de
SELECT-knop.

3 Ga naar ‘On/Off’ en druk op de SELECT-knop.
● On : De presetmodus is geselecteerd. Selecteer de

vooringestelde frequentie met behulp van de
knoppen , .

● Off : De FM-ontvangstmodus is geselecteerd.

I Preset Mode
Mono/Stereo

TOOL

Preset Mode

Edit Preset

Auto Preset
Off

On

✍
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Van de radio opnemen

1 Druk tijdens het FM-ontvangst op de REC-knop en houd vast.
● Het scherm ‘Recording’ verschijnt.

2 Druk op de REC-knop.
● De actueel FM-uitzending zal opgenomen worden.

3 Druk nogmaals op de REC-knop.
● Het opnemen wordt gestopt en het bestand wordt gemaakt.
● Bestanden worden opgenomen onder de namen F001.mp3, F002.mp3, enzovoort.
● De MP3-bestanden worden toegevoegd aan [Navigation] → [File Search] →

[RECORDED] → [FM]. U kunt tot 999 bestanden in een opnamemap bewaren.
● Druk op de knop √» om het opgenomen bestand te spelen.

-REC:Start -TOOL:Exit F001.mp3

108.00 MHz 108.00 MHz

Spraakopname maken

50

-REC:Start -TOOL:Exit

1 Druk op de REC-knop en houd vast.
● Het scherm ‘Recording’ verschijnt.

2 Druk op de REC-knop.

3 Druk nogmaals op de REC-knop.
● Het opnemen wordt gestopt en het bestand wordt gemaakt.
● Bestanden worden opgenomen onder de namen V001.mp3, V002.mp3, enzovoort.
● De aangemaakte MP3-bestanden worden toegevoegd in de bestandsmap [Navigation] →

[File Search] → [RECORDED] → [VOICE]. U kunt tot 999 bestanden in een opnamemap
bewaren.

● Druk op de knop √» om het opgenomen bestand te spelen.

OOppmmeerrkk iinngg
- Zelfs als u de samplingfrequentie en bitsnelheid instelt op een hogere waarde, wordt standaard

44.1khz gebruikt voor een spraakopname.

✍

V001.mp3
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File Search
Music Library
Playlist

Navigation

MUSIC
PHOTO
RECORDED
TEXT
VIDEO
POP

File Search

Sexy boms.mp3
blue.mp3
Ill be there for you.mp3
San eye.mp3
Only for you.mp3
Happy.mp3

MUSIC

1 Druk op de SELECT-knop en houd vast om naar de navigatiemodus te gaan, of
druk op de MENU-knop om naar het Menu te gaan en dan Navigation te selecteren.
● File Search : U kunt een bestand zoeken in de bestandsmappen MUSIC, PHOTO, TEXT of VIDEO.
● Music Library : U kunt een muziekbestand zoeken op Artiest, Album, Genre en Track.
● Playlist : U kunt in de speler een bestand zoeken dat gespecificeerd is als Favoriet of u

kunt een speellijst van de pc zoeken dat is verzonden via Media Studio.

2 Selecteer het bestand of de bestandsmap, dat/die u wilt spelen.
● : Naar een hogere map gaan.
● : Naar een submap gaan.
● ▲ ,▼ : Naar een bestand of bestandsmap in dezelfde directory gaan.
● SELECT : Naar de volgende submap gaan.

3 Druk op de SELECT-knop.
● Het geselecteerde bestand zal gespeeld worden.

● U kunt navigeren en selecteren met behulp van de SELECT-knop.
● Druk op de knop om naar het vorige scherm te gaan.

MP3's opnemen
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1 Sluit de Audio OUT-poort van de
externe geluidsbron (of de Line
Out-poort) aan de LINE IN-poort van
het apparaat met de Line-kabel aan.
● Druk op de afspeelknop op het externe

apparaat om de muziek af te spelen die
u wilt opnemen.

2 Druk op de REC-knop en houd vast.
● Het scherm ‘Recording’ verschijnt.

3 Druk op de REC-knop.
● De opname begint.

4 Druk nogmaals op de REC-knop.
● Het opnemen wordt gestopt en het bestand wordt gemaakt.
● Bestanden worden opgenomen onder de namen L001.mp3, L002.mp3, enzovoort.
● De MP3-bestanden worden toegevoegd aan [Navigation]_[File Search] → [RECORDED]

→ [LINE]. U kunt tot 999 bestanden in een opnamemap bewaren.
● Druk op de knop √» om het opgenomen bestand te spelen.

LLeett   oopp
- Koppel de Line In-kabel niet los tijdens het opnemen.
- Als de batterij niet voldoende is opgeladen, kan de speler het bestand niet volledig coderen.
- Pas het volume van de externe geluidsbron aan tot een geschikt niveau en opnieuw codeer.

Als het volume te hoog is, laat de geluidskwaliteit mogelijk te wensen over.

-REC:Start -TOOL:Exit L001.mp3

✍
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1 Ga in de navigatiemodus naar het muziekbestand
en druk op de TOOL-knop.
● Het scherm ‘Navigation Tool’ verschijnt.

2 Ga naar [Add to Favorites] en druk op de
SELECT-knop.

3 Bewaar de lijst en druk op de SELECT-knop.
● Het geselecteerde bestand zal aan de lijst toegevoegd worden.
● Er kunnen 10 speellijsten worden geselecteerd.
● Toegevoegde bestanden kunnen worden gevonden in [Navigation] → [Playlist] → [Favorites].

I Add to Favorites

●  Opgenomen bestanden kunnen in de
navigatiemodus worden geschrapt. Andere
bestanden kunnen met behulp van Media Studio
worden geschrapt.

1 Ga in de navigatiemodus naar het opgenomen
bestand en druk op de TOOL-knop.
● Het scherm ‘Navigation Tool’ verschijnt.

2 Ga naar [Delete File] en druk op de SELECT-knop. 
● Het geselecteerde bestand wordt geschrapt.

I Delete File
V001.MP3
V002.MP3
V003.MP3

VOICE001

Go to Top
Add to

TOOL

List 1
List 2
List 3
List 4
List 5

Go to Top
Delete File

TOOL

De hoofdfuncties in de navigatie instellen
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Go to Top
Add to Favorites

TOOL

1 Druk in de navigatiemodus op de TOOL-knop.
● Het scherm ‘Navigation Tool’ verschijnt.

2 Ga naar [Go to Top] en druk op de SELECT-knop.
● Ga naar het scherm ‘File Navigation’.

I Go to Top

● U kunt navigeren en selecteren met behulp van de SELECT-knop.
● Druk op de knop om naar het vorige scherm te gaan.

File Search
Music Library
Playlist

Navigation
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De hoofdfuncties in Text instellen
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Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Add
Move

● U kunt navigeren en selecteren met behulp van de SELECT-knop.
● Druk op de knop om naar het vorige scherm te gaan.

1 Druk tijdens het bekijken of lezen van de tekst op de TOOL-knop.
● Het scherm ‘Text Tool’ verschijnt.

2 Ga naar [Bookmark] en druk op de SELECT-knop.

3 Ga naar [Add] of [Move] en druk op de SELECT-knop.
● Add : Er wordt een bladwijzer op de actueel pagina aangemaakt.
● Move: Ga naar een bladwijzer in het tekstbestand.

I Bookmark

OOppmmeerrkk iinngg
- U kunt 1 bladwijzer in een bestand of 5 bladwijzers binnen een directory aanmaken.

✍

Tekst bekijken
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OOppmmeerrkk iinngg
- Tekstbestanden met een grootte van 500 KB of meer kunnen niet worden gelezen.

✍

Door.txt
Identity.txt
The Little Prince.txt

TEXT The Little Prince 0011
/0102

Once when I was six
years old I saw a mag-
nificent picture in a
book, called True
Stories from Nature,
about the primeval for

1 Druk op de MENU-knop om naar het menu te gaan en selecteer dan Text.
● Het scherm ‘Navigation Tool’ verschijnt.

2 Ga naar de tekst die u wilt lezen en druk op de SELECT-knop.
● Het geselecteerde tekstbestand wordt weergegeven.

- ▲,▼ : Volumeregeling
- , : Naar de vorige/volgende pagina gaan.
- Tekstbestandselectie : Druk tijdens het spelen van muziek op de SELECT-knop en houd

vast om naar navigation te gaan. Ga naar het gewenste tekstbe-
stand en druk op de SELECT-knop.

04 I Text

● Met Text Viewer kunt u tekstbestanden lezen die zijn gemaakt op de PC.
Tekstbestanden kunnen alleen worden weergegeven in Text Viewer als zij de extensie .txt hebben.

● U kunt een tekstbestand selecteren om te bekijken tijdens het beluisteren van muziek.
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De hoofdfuncties in Text instellen
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1 Druk tijdens het bekijken van de tekst op de
TOOL-knop.
● Het scherm ‘Text Tool’ verschijnt.

2 Ga naar [Page Scroll Type] en druk op de
SELECT-knop.

3 Ga naar de gewenste schermrolinstellingen en
druk op de SELECT-knop.
● Line Up/Down : Druk op de knoppen , en navigeer 1 regel in een keer

door de tekst. 
● Page Up/Down : Druk op de knoppen , en navigeer 1 pagina in een keer

door de tekst.

I Page Scroll Type

1 Druk tijdens het bekijken van de tekst op de
TOOL-knop.
● Het scherm ‘Text Tool’ verschijnt.

2 Ga naar [Auto Scroll] en druk op de SELECT-knop.

3 Ga naar de gewenste automatische schermroltijd
en druk op de SELECT-knop.
● U kunt kiezen uit Off, 1, 3, 5 of 10 seconden.
● De pagina verspringt automatisch nadat u de tijd hebt ingesteld.

I Auto Scroll

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Line Up/Down
Page Up/Down

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

Off
1 sec
3 sec
5 sec
10 sec

De hoofdfuncties in Text instellen

58

The Little Prince 0011
/0102

Once when I was six
years old I saw a
magnificent picture in
a book, called True
Stories from Nature,
about the primeval for

Bookmark
Go to page
Page Scroll Type
Auto Scroll

TOOL

0 0 1 1 /0102

Alle pagina’s

1 Druk tijdens het bekijken van de tekst op de TOOL-knop.
● Het scherm ‘Text Tool’ verschijnt.

2 Ga naar [Go to Page] en druk op de SELECT-knop.

3 Selecteer de gewenste pagina en druk op de SELECT-knop.
● Naar de geselecteerde pagina gaan.
● SELECT: De pagina selecteren.
● , : Het invoerveld verplaatsen.

I Go to page

▲ ▲ ▲ ▲

▲▲▲▲
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Videobestanden bekijken
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05 I Photo/Video
Photo
Video

Photo/Video

Arthur.Svi
SDIARY.Svi
TOM.Svi

VIDEO

1 Druk op de MENU-knop om naar het menu te gaan en selecteer dan
‘Photo/Video’.
● Het scherm ‘Photo/Video’ verschijnt.

2 Ga naar de map [Video] en druk op de SELECT-knop.

3 Ga naar de video die u wilt bekijken en druk dan op de MENU-knop.
● Het geselecteerde videobestand wordt gespeeld.
● ▲ ,▼ : Volumeregeling
● (Kort) , : Naar de vorige/volgende video gaan.
● (Lang) , : Snel zoeken
● MENU: Naar het menuscherm gaan.
● TOOL: Videotitel, voortgangtijd en totale tijd controleren

OOppmmeerrkk iinngg
- De speler ondersteunt alleen videobestanden met de .svi extensie. Om videobestanden met een

andere bestandsopmaak te kunnen bekijken, dient u deze bestanden eerst met behulp van
Multimedia Studio te converteren om deze vervolgens naar de speler te verzenden.
Raadpleeg voor het verzenden van een videobestand van een ander format de alinea
“Video’s verzenden” in het hoofdstuk “Multimedia Studio gebruiken”. (Zie pagina 34)

✍

Afbeeldingsbestanden bekijken
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05 I Photo/Video
Photo
Video

Photo/Video
HOTELSEA.JPG
SKYSHOW.JPG
flowerpicture.jpg
manillasunset.jpg
sebusunrise.jpg

PHOTO

1 Druk op de MENU-knop om naar het menu te gaan en selecteer dan Photo/Video.
● Het scherm ‘Photo/Video’ verschijnt.

2 Ga naar de map [Photo] en druk op de SELECT-knop.

3 Ga naar de afbeelding die u wilt bekijken en druk dan op de MENU-knop.
● De geselecteerde afbeelding wordt nu getoond.
● ▲ ,▼ : Volumeregeling
● , : Naar de vorige/volgende afbeelding gaan.
● MENU: Naar het menuscherm gaan.
● TOOL: Het scherm ‘Image Tool’ verschijnt wanneer u de TOOL-knop indrukt. Selecteer

[Slide Show] → [On] in het scherm ‘Image Tool’ om de bewaarde bestanden als
diavoorstelling te bekijken.

OOppmmeerrkk iinngg
- Het optimale afbeeldingsformaat voor het apparaat is 160X128. Als de afbeelding te groot is,

gebruikt u Multimedia Studio om het formaat aan te passen en de afbeelding opnieuw naar de
speler te sturen. (zie pagina 32).

- Afbeeldingsbestanden met een grootte van 2 MB of meer kunnen niet worden bekeken.

✍
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De USB Host gebruiken
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1 Ga naar het bestand dat u naar de speler wilt verzenden en druk op de
SELECT-knop.  
● ▲ ,▼ : Omhoog of omlaag gaan.

● SELECT : Naar een submap gaan of een bestand selecteren.

2 Druk op de TOOL-knop om naar het scherm ‘USB Tool’ te gaan en selecteer dan
[Cut] of [Copy].
● Cut: Indien u het geselecteerde bestand in de J70 plakt, wordt het originele bestand

geschrapt.

● Copy: Het geselecteerde bestand wordt gekopieerd.

3 Druk op de knop om naar [YH-J70] te gaan en druk dan op de SELECT-knop.
● Het scherm ‘YH-J70 Navigation’ verschijnt.

I Bestanden vanaf een Extern Apparaat naar de speler verzenden

01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave Device
01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
Iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave Device
01-Don’t Know Why.
01-Politik.mp3
01-Solsbury Hill.mp3
Iltans Of Swing.mp3
02-Come with Me.mp
02-Hollywood.mp3

Slave DeviceTOOL

Copy

Cut
Paste
USB disconnect

Vervolg…

De USB Host gebruiken
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Extern USB-apparaat

Speler

USB-kabel (Extern Apparaat)

USB-Host Adapter

1 Sluit de speler aan op de USB-host-adapter.

2 Gebruik de USB-kabel van het externe apparaat om het daarmee aan te sluiten
op de USB-host-adapter.

3 Druk op de MENU-knop om naar het MENU-scherm over te schakelen.
Selecteer USB Host en druk vervolgens op de SELECT-knop.

4 Gebruik de SELECT-knop om naar ‘Please connect een slave device [OK]’ te
gaan en druk dan op de SELECT-knop.
● Het Extern Apparaat-scherm zal nu verschijnen.

I Een extern apparaat aansluiten

Please connect a
slave device

05 I USB Host

OK Cancel

COPIED
GAME
MUSIC
PHOTO
PLAYLIST
RECORDED

Slave Device

● Indien u de USB-hostfunctie wilt gebruiken, moet de capaciteit van het aan te sluiten
externe apparaat gelijk zijn aan of groter zijn dan 128 MB.

● Het externe apparaat moet een FAT 16/32-bestandsysteem hebben.
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De USB Host gebruiken
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I YH-J70 USB-HOST Compatibel
● U kunt afbeeldingen vanuit de hieronder genoemde camera's overdragen naar uw

YH-J70 voor opslag.
● Hieronder volgt een lijst met camera's die compatibel zijn met de USB-hostfunctie van

de YH-J70.
● Deze lijst kan wijzigen bij firmware-verbeteringen (upgrades). 

Fuji Finepix-A340

Fuji Finepix-F450

Fuji Finepix-F810

Panasonic Lumix-FZ20

Olympus 300-Digital

Pentax Optio-S40

H.P. Photosmart 945

NIKON COOLPix 4200

NIKON COOLPix 4300

NIKON COOLPix S1

Panasonic DMC-FX7

YP-55

YP-MT6

YP-T6

YP-ST5

YP-T5

YP-53

YH-920

YP-T7

YH-925

YP-C1

YP-60

YP-T8

MP3 Speler
(Samsung)

Digitale Camera

ModelnummerModelnummerApparaat Apparaat

De USB Host gebruiken
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4 Naar een bestandsmap gaan waarin het bestand of het externe apparaat moet
worden gekopieerd.

5 Druk op de TOOL-knop om naar het scherm ‘USB Tool’ te gaan en selecteer
dan [Paste].
● Het geselecteerde bestand wordt naar de speler verzonden. Niet de speler of het externe

apparaat tijdens het verzenden uit van het bestand schakkelen.

OOppmmeerrkk iinngg
- Volgens dezelfde procedures als hierboven kunt u de bestanden in de speler naar een extern apparaat

verzenden.

✍

YH-J70
Slave Device

USB HOST
01-As long as you lov
I’ll be there.mp3
01-Goodbye.mp3
go away.mp3
please.mp3
dreams come true.m

YH-J70

01-As long as you lov
01-love.mp3
01-Goodbye.mp3
go away.mp3
please.mp
dreams come true.m

YH-J70TOOL

Copy
Cut
Paste
USB disconnect
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Een spel spelen
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1 Druk op [START] om het spel te starten.

[Hoe dit spel te spelen]
- Als u uw stenen horizontaal, verticaal en diagonaal plaatst, worden de stenen in

het geplaatste vak van u.
De speler met de meeste stenen na het spel, wint.

- ▲,▼ ,SELECT: Omhoog en omlaag navigeren en selecteren
- , : Naar links en naar rechts navigeren
- TOOL: Opnieuw spelen, sluiten

I Othello

Aantal gele stenen

Aantal roze stenen

START

HELP

EXIT

66

Een spel spelen

Actueel level

Aantal resterende stenen

● Druk op de MENU-knop om naar het menu te gaan en selecteer dan ‘Games’.
● Ga naar het gewenste spel en druk op de SELECT-knop.

1 Druk op [START] om het spel te starten.

2 Selecteer, wanneer het levelscherm verschijnt, de level met behulp van de SELECT-knop.

[Hoe dit spel te spelen]
- Het doel van dit spel is het scherm op te ruimen door de 4 richtingen van de

geselecteerde locatie achteruit te rijden.
Bijv. Als u in level 1 een steen in het midden selecteert, worden de 4 richtingen

omgedraaid en is het scherm opgeruimt.
- ▲,▼ ,SELECT: Omhoog en omlaag navigeren en selecteren
- , : Naar links en naar rechts navigeren
- TOOL: Opnieuw spelen, sluiten

I Clear Screen

START

HELP

EXIT

1
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Een spel spelen
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1 Druk op [START] om het spel te starten.

I Tetris

2 Selecteer, wanneer het levelscherm verschijnt, de level met behulp van de SELECT-knop.

[Hoe dit spel te spelen]
- Het doel van het spel is rijen op te ruimen door verschillend gevormde blokken te

stapelen.

- SELECT : Blokvormen veranderen
- , : Naar links en naar rechts navigeren
- ▼ : Neerhalen
- TOOL: Opnieuw spelen, sluiten

Level
Aantal op te ruimen rijen in het actueel level
Score

START

HELP

EXIT

LINES :    30
SCORE :    0

Een spel spelen
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1 Druk op [START] om het spel te starten.

[Hoe dit spel te spelen]
- De speler met 5 rechte stenen in een horizontale, verticale of diagonale rij,

wint het spel.
- ▲,▼ ,SELECT: Omhoog en omlaag navigeren en selecteren
- , : Naar links en naar rechts navigeren
- TOOL: Opnieuw spelen, sluiten

I Omok
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Geavanceerde functies instellen
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1 Druk op de MENU-knop om naar het menu te gaan en selecteer dan ‘Settings’.

2 In ‘Settings’ gaat u naar de gewenste functie en drukt u op de SELECT-knop
om te selecteren.
● Druk op de knop om naar het vorige menu te gaan.

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings
Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings
Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

Display
Sound Effect
Time/Schedule
FM Radio
Record
System

Settings

08 I Settings

Een spel spelen
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Playing Games

1 Druk op [START] om het spel te starten.

I Chips

2 Selecteer, wanneer het levelscherm verschijnt, de level met behulp van de SELECT-knop.

[Hoe dit spel te spelen]
- Het doel van het spel is de eindpoort te bereiken door obstakels te verplaatsen, en

sleutels en voorwerpen te verwerven. U kunt alleen een poort passeren wanneer u
de sleutel hebt. En u kunt alleen naar een volgende level gaan indien u het vereiste
aantal voorwerpen in de actueel level hebt verzameld.

- ▲,▼ : Omhoog en omlaag navigeren en selecteren
- , : Naar links en naar rechts navigeren
- TOOL : Opnieuw spelen, sluiten

Actueel
level

X

START

HELP

EXIT

Het resterende aantal voorwerpen dat u in het
actueel level moet verzamelen
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● Gebruik de SELECT-knop om de uittijd van het LCD in te
stellen.

● De uittijd van het LCD kan worden ingesteld op
10 seconden, 20 seconden, 30 seconden en Always On
(altijd aan).

● Wanneer u ‘Always On’ selecteert, blijft het licht
onafgebrochen branden.

● Het scherm schakelt na de ingestelde tijd uit.
Het scherm weer verschijnt wanneer een knop wordt
ingedrukt.

I Lcd Off Time

10 sec
20 sec
30 sec
Always On

Lcd Off Time

1 Een gewenste tekstkleur selecteren.
● , : Naar links en naar rechts navigeren

● ▲ ,▼, SELECT: Selecteren

2 Nadat de instelling voltooid is, ga naar OK en druk
dan op de SELECT-knop.
● Als u een kleur selecteert, zal tekst in die kleur worden

vertonen.

I Text Set

OK Cancel

Color

Text Set

Instellingen Schermbeeld
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● Gebruik de SELECT-knop om de schermrolsnelheid
in te stellen en om de snelheid van de beweging
van de tracktitel aan te passen.

● De schermrolsnelheid kan worden ingesteld op
0,5x, 1x, 1,5x of 2x.

I Scroll Speed

● Gebruik de SELECT-knop om de tijdsduur van het
achtergrondlicht in te stellen.

● De tijdsduur van het achtergrondlicht kan worden
ingesteld op Off, 3 seconden, 5 seconden, 10 seconden of
Always On (altijd aan).

● Wanneer u ‘Always On’ selecteert, blijft het licht
onafgebrochen branden.

I Backlight

Druk op de MENU-knop om naar het menu te gaan en selecteer dan [Settings] → [Display]. 

0.5x
1x
1.5x
2x

Scroll Speed

Off
3 sec
5 sec
10 sec
Always On

Backlight
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Instellingen geluidseffecten

N
L

● Gebruik de SELECT-knop om ‘Automatic EQ On/Off’ te selecteren.
● On : EQ wordt automatisch geselecteerd uit Jazz, Classic, Pop of Rock in overeenstemming

met de ID3-taginformatie van het muziekbestand.
● Off : Het muziekbestand wordt in de actueel gekozen EQ-modus gespeeld.

I Auto EQ

- Beschermt uw oren door het volume geleidelijk te laten
toenemen als het spelen start.

● Gebruik de SELECT-knop om de gewenste fade out-tijd te
selecteren.
- Off : De muziek wordt gespeeld op het geselecteerde

volume.
- 3 sec : Muziek zwelt geleidelijk aan gedurende 3 seconden.
- 5 sec : Muziek zwelt geleidelijk aan gedurende 5 seconden.

I Fade In

EQ-MODUS TAG INFO

CLASSIC ROCK, CHRISTIAN ROCK, ROCK,
ALTERNROCK, INSTRUMENTAL ROCK,

ROCK
SOUTHERN ROCK, ROCK & ROLL, HARD ROCK,
FOLK-ROCK, GOTHIC ROCK, PROGRESSIVE ROCK,
PSYCHEDELIC ROCK, SYMPHONIC ROCK,
SLOW ROCK, PUNK ROCK, DEATH METAL

CLASSIC
CLASSIC, OPERA, CHAMBER MUSIC
SONATA, SYMPHONY

JAZZ JAZZ, JAZZ+FUNK, ACID JAZZ

POP
POP, INSTRUMENTAL POP, POP-FOLK, DANCE
EURODANCE, DANCEHALL, DISCO, HIP-HOP

On
Off

Auto EQ

Off
3 sec
5 sec

Fade In
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Instellingen geluidseffecten

1 Het gewenste WOW-niveau selecteren.
● De WOW-niveauregeling wordt alleen toegepast als SRS,

TruBass of WOW is geselecteerd. U kunt SRS en TruBass
van 0 tot 10, en Definition, Limiter van 0 tot 2 instellen. 

● SELECT : Omhoog en omlaag navigeren en selecteren
● , : Niveau verplaatsen
● SRS : U hoort een 3D-stereogeluid.
● TruBass : Dit is de basversterkingsfunctie die het geluid voller doet klinken.
● Definition: Herstelt verloren geluid aan het origineel en levert een betere geluidskwaliteit.
● Limiter: Minimaliseert de geluidsvervorming dat wordt geproduceerd tijdens het

terugspelen van muziek.

2 Nadat de instelling voltooid is, ga naar OK en druk dan op de SELECT-knop.

- Het optimaliseert de SRS-functie in overeenstemming
met het aangesloten apparaat.

● Gebruik de SELECT-knop om naar het aangesloten
apparaat te gaan.

● Earphone → Headphone → Speaker → Carpack

I WOW Level

I WOW Optimum

Druk op de MENU-knop om naar het menu te gaan en selecteer dan [Settings] → [Sound Effect].

Earphone
Headphone
Speaker
Carpack

WOW Optimum

OK Cancel

SRS
TruBass
Definition
Limiter

5
5
1
1

WOW Level
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Instellingen Time/Schedule
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1 Selecteer [New Memo] als het scherm ‘Memo’ verschijnt.

2 Voer de gewenste inhoud in.
● Invoerprocedure

Ga naar de gewenste sleutel met behulp van de
knoppen ▲,▼, en en druk op de
SELECT-knop.

Druk tweemaal op de SELECT-knop om de
tweede letter van de sleutel in te voeren.

Ex) om ‘MOVE’ in te voeren,

Ga naar de overeenkomstige sleutel en druk
op de SELECT-knop.

(Eenmaal) → (3 maal) → (3 maal) → (2 maal)

● Selecteer om een letter te verwijderen en selecteer om een spatie in te voeren.

I Memo

Druk op de MENU-knop om naar het menu te gaan en selecteer dan [Settings] →
[Time/Schedule].

Memo

OK Cancel

OOppmmeerrkk iinngg
- U kunt niet meer dan één pagina aan memo’s invoeren.

✍

Vervolg…

Instellingen geluidseffecten
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- Als ‘User EQ’ in de EQ-modus geselecteerd is,
kan EQ in de ‘User EQ Set’ bij uw voorkeur
worden ingesteld.

● Gebruik de knop , om naar rechts of naar links
te navigeren en gebruik de SELECT-knop om het niveau
aan te passen.
Nadat de instelling voltooid is, ga naar OK en druk dan
op de SELECT-knop.

I User EQ Set

● Gebruik de SELECT-knop om ‘Clicker On/Off’ te selecteren.

● On : Een klikgeluid klinkt als de knoppen worden ingedrukt.

● Off : Er is geen klikgeluid als een knop wordt ingedrukt.

I Clicker

On
Off

Clicker

OK Cancel

User EQ Set

60     250    1K     4K     16K
125    500    2K     8K

+10dB

0dB

-10dB
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PM

Folder

NORMAL

MP3

NOR05:38

192kbps √ 003/007

35

JOY.mp3

OO:00:40

1 Gebruik de knoppen , om de sluimertijd in te
stellen.
● De sluimertijd kan worden ingesteld op Off, 10~120

minuten. De speler zal automatisch worden uitgeschakeld
na de ingestelde sluimertijd.

● Als de sluimertijd is ingesteld op Off, dan is deze functie
geblokkeerd.

2 Nadat de instelling voltooid is, ga naar OK en druk
dan op de SELECT-knop.

I Sleep

● U kunt de actuele datum en tijd instellen.

1 Gebruik de SELECT-knop om naar de volgende fase te gaan, en selecteer
vervolgens het jaar, de maand en de datum met behulp van de knoppen , . 

2 Ga naar 'Time' en druk op de knop .

3 Gebruik de knoppen , om de actueel tijd in te stellen en druk vervolgens
op de SELECT-knop.

4 Nadat de instelling voltooid is, ga naar OK en druk dan op de SELECT-knop.

I Date/Time

Sleep Time

OK Cancel

30 Min

Date/Time
2005

07 FRI
1 (JAN)

01:17 AM

OK Cancel

Year

Day
Month

Time

▼

▼

▼

▼

▼

▼
▼

Instellingen Time/Schedule
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1 Druk op de TOOL-knop in het scherm ‘Calendar’.
● Day: Per dag navigeren

● Month: Per maand navigeren

● Year: Per jaar navigeren

2 Ga naar de datum die u wilt controleren.
● ▲,▼ : Omhoog en omlaag navigeren

● , : Naar links en naar rechts navigeren

3 Druk na de controle op de SELECT-knop.
● Het vorige scherm wordt vertonen.

3 Druk op de TOOL-knop.
● Keypad Set : U kunt het toetsenbord veranderen. 

U kunt Korean → Numeric → Capital English Font →
Small English Font → Special Characters selecteren.

● Clear : De gehele memo schrappen.

4 Nadat de invoer voltooid is, ga naar OK en druk
dan op de SELECT-knop.

»≠∏È ¡̂ øÚ

OK Cancel

Keypad Set 
Clear

Tool

123
ABC
abc
!~^

Calendar
42005

3
10
17
24

4
11
18
25

5
12
19
26

6
13
20
27

7
14
21
28

1
8
15
22
29

2
9
16
23
30

I Calendar

▲
▼

▲
▼

OOppmmeerrkk iinngg
- Ga om een memo te schrappen naar het scherm ‘Select Memo list’ en druk op de TOOL-knop.

Selecteer vervolgens [Delete] om de memo te schrappen.

✍
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Opname-instellingen
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Druk op de MENU-knop om naar het menu te gaan en selecteer dan [Settings] → [Record].

● Gebruik de SELECT-knop om de gewenste
opnamebitsnelheid te selecteren.

● De opnamebitsnelheid kan worden ingesteld op
40 kbps, 64 kbps, 96 kbps 128 kbps of 192 kbps.

I Bit Rate

● Gebruik de SELECT-knop om de ‘Auto Sync Time’
in te stellen.

● Auto Sync Tijd is een functie die wordt gebruikt voor
het scheiden en opslaan van MP3 bestanden als
tijdens een MP3-opname gedurende een vooraf
ingestelde tijdsduur een stilte optreedt.

● Met de SYNC 1 instelling zal een opname stoppen en
gaat het apparaat naar de Muziekmodus als tijdens een
opname gedurende meer dan 2 seconden geen geluid
waarneembaar is. 

● Als de Auto Sync Tijd uitgeschakeld is, zal de opname
doorgaan, ook als er geen geluid is, en in dat geval
wordt het bestand na de opname opgeslagen als één
bestand. 

I Auto Sync

40 kbps
64 kbps
96 kbps
128 kbps
192 kbps

Bit Rate

Off
Sync1
On

Auto Sync
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FM-radio instellen

Korea/US
Other Country

FM Region

Low
Mid
High

FM Search Level

● Gebruik de SELECT-knop om de gewenste
FM-ontvangstgebied in te stellen.
- Korea/U.S : Zoek naar FM-zenders tussen 87.5MHz

en 108.0MHz in stappen van 100 kHz.
- Other Country : Zoek naar FM-zenders tussen

87.5MHz en 108.00MHz in stappen
van 50 kHz.

I FM Region

● Gebruik de SELECT-knop om het gewenste
FM-zoekniveau in te stellen. 
- Hoe hoger de gevoeligheid van de FM-tuner, hoe

meer zenders kunnen worden ontvangen. 
- Low → Mid → High

I FM Search Level

Druk op de MENU-knop om naar het menu te gaan en selecteer dan [Settings] → [FM Radio].

OOppmmeerrkk iinngg
- De standaard FM-regio-instellingen kunnen variëren, afhankelijk van de beoogde regio van het

afspeelapparaat.

✍



83

Systeeminstellingen
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● Gebruik de SELECT-knop om de gewenste
speelsnelheid te selecteren.

● De afspeelsnelheid kan worden ingesteld op een
waarde van x0.8, x1, x1.2, x1.4 of x1.6.

● Hoe groter het getal, hoe sneller de afspeelsnelheid,
en hoe kleiner het getal, hoe langzamer de
afspeelsnelheid.

I Play Speed

● Gebruik de SELECT-knop om ‘Resume On/Off’ te
selecteren.

● On : Het afspelen wordt hervat vanaf het punt waarop het
afspelen de vorige keer was gestopt. In het geval van
een tekstbestand zal de tekst worden hervat vanaf
het punt dat het de laatste keer bekeken is.

● Off : Het terugspelen wordt hervat vanaf het begin
van het bestand of de track, dat/die tijdens het
terugspelen werd onderbroken. In het geval van een
tekstbestand zal de tekst worden hervat vanaf het
begin van het bestand.

I Resume

0.8x
1x
1.2x
1.4x
1.6x

Play Speed

On
Off

Resume

Removable Disk
Charge

PC Connect Mode
● Gebruik de SELECT-knop om modus ‘PC Connection’

te selecteren.
● Removable Disk: Bestanden op een verwijderbare

schijf bewaren of afbeeldings- en videobestanden
verzenden met behulp van Multimedia Studio.

● Charge: Laden via de USB-kabel.

I PC Connect Mode
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Systeeminstellingen

English
Korean
Japanese
Simplified Chinese
Traditional Chinese
Russian

File Language

Languages

Druk op de MENU-knop om naar het menu te gaan en selecteer dan [Settings] → [System].

● Gebruik de SELECT-knop om de gewenste
taal voor het menuscherm te selecteren. 

●

I Languages

● Gebruik de SELECT-knop om de gewenste taal voor
de tag-info en teksten te selecteren.

● English → Korean → Japanese → Simplified Chinese →
Traditional Chinese → Russian → Spanish → French →
German → Italian → Albanian → Afrikaans → Basque →
Bulgarian → Byelorussian → Catalan → Czech → Croatian →
Danish → Dutch → Estonian → Faeroese → Finnish →

Galician → Hungarian → Icelandic → Irish → Latvian →
Lithuanian → Macedonian → Norwegian → Polish →
Porthguuese → Rhaeto-Romanic → Romanian →
Scottish → Serbian → Singaporean → Slovak → Slovenian →
Swahili → Swedish → Ukrainian

I File Language

OOppmmeerrkk iinngg
- Wat is een ID3-tag?

Dat zijn gegevens die aan een MP3 wordt verbinden en informatie bevatten die relevant zijn
voor het bestand, zoals titel, artiest, album, jaar en genre. Er is ook ruimte voor opmerkingen in
een ID3-tag.

- Ondersteunde talen kunnen gewijzigd of toegevoegd worden.

✍
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Tabel MENU

‚ · ” ¨ › ‚ ØMENU

MUSIC FM Radio Navigation Text Photo/Video USB Host Games Settings

Clear Screen

Othello

Omok

Tetris

Chips

Scroll Speed

Backlight

Lcd Off Time

Text Set

WOW Level

WOW Optimum

Memo

Calendar

FM Region

FM Search Level

Bit Rate

Auto Sync

Languages

File Language

Play Speed

Resume

PC Connect Mode

Defualt Set

About

Auto EQ

Fade In

Sleep

Date/Time

User EQ Set

Clicker

Display Sound Effect Time/Schedule FM Radio Record System

● Gebruik de SELECT-knop om te navigeren en te selecteren.
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Systeeminstellingen

Volume = 40

Repeat = OFF

Sound Effects Settings = OFF

Backlight = 3 Seconden

Begininstellingen

No
Yes

Default Set

● Gebruik de SELECT-knop om de standaardinstellingen ‘Yes’ of ‘No’ te selecteren.
● Als u [Yes] selecteert, wordt een pop-upscherm vertonen. Als u [OK] selecteert, zullen alle

geselecteerde instellingen worden teruggezet naar de standaardinstellingen.

I Default Set

● Selecteer ‘About’ om de totale capaciteit, beschikbare capaciteit en de
softwareversie te controleren.

I About
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Problemen oplossen

De weergave van de afspeeltijd tijdens het afspelen lijkt onjuist.
● Controleer of u een VBR (Variable Bit Rate) bestand aan het afspelen bent.

VBR-bestanden worden slechts gedeeltelijk ondersteund. 

De knoppen van de speler reageren niet.
● Controleer of de Hold-schakelaar in de ‘uit’-stand staat.
● Controleer of de USB-kabel is aangesloten.

Wanneer de USB-kabel aangesloten is, reageren de knoppen niet.

Het LCD-venster is te donker.
● Controleer de uittijd van het achtergrondlicht/LCD.

Tijdens het afspelen worden onbekende tekens weergegeven op het display.
● Niet-ondersteunde talen worden aangegeven met een vraagteken (?).

“Null” verschijnt op het terugspeelscherm in plaats van de titel van het geselecteerde
muziekbestand.
● Er is geen ID3-taginformatie beschikbaar voor het muziekbestand. Bewerk de titel, artiest en

albuminformatie van het nummer.

Het duurt lang als ik nummers zoek op titel, artiest of album.
● Als er te veel muziekbestanden op uw speler staan, duurt het langer om deze in te lezen.
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Problemen oplossen

Het bestandszoekactie werkt niet goed in het menu ‘Navigation’.
● Nadat de speler aan de pc aangesloten is, dient u Media Studio te runnen en vervolgens

[Device] → [Reconstruct Library] te selecteren.

De speler werkt niet. Er is niets te zien op het display.
● Reset de speler.
● Sluit de oplader aan.
● Controleer of de Hold-schakelaar in de ‘uit’-stand staat.

Er is geen geluid ook al druk ik op de afspeelknop in de muziekmodus.
● Controleer of de speler MP3- of WMA-bestanden bevat.
● Niet-afspeelbare bestandsindelingen (bijv. MPEG1 LAYER 1-bestanden) kunnen niet worden

afgespeeld.

Ik kan geen bestanden downloaden.
● Controleer de batterijen van het apparaat.
● Controleer of het stuurprogramma correct is geïnstalleerd op uw pc.

De speler wordt uitgeschakkelt, indien u de pc herstart terwijl de speler aan de pc is aangesloten. 
Probeer de speler opnieuw aan te sluiten.

● De speler is zo ontworpen dat hij het achtergrondlicht automatisch uitschakelt voor langere 
bedieningstijd wanneer het overgebleven voltage van de batterij laag is.

De achtergrondverlichting werkt niet.
● De instellingen voor de achtergrondverlichting (Backlight).
● De achtergrondverlichting wordt automatisch uitgeschakeld om een langere afspeeltijd te

garanderen als de batterij bijna leeg is.
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Specificaties

Op dit apparaat en de gebruiksaanwijzing rusten intellectuele eigendomsrechten en
auteursrechten van derden. Het gebruiksrecht van de gelicentieerde inhoud is beperkt 
tot niet-commercieel gebruik door eindgebruikers. Commercieel gebruik hiervan is niet
toegestaan. 
Het gebruiksrecht beperkt zich tot dit apparaat en strekt zich niet uit tot andere 
niet-gelicentieerde onderdelen of processen die voldoen aan ISO/IEC 11172-3 or 
ISO/IEC 13818-3 en die in combinatie met dit product gebruikt of verkocht zijn. De licentie
beperkt zich tot het gebruik van dit product voor het encoderen en/of decoderen van 
geluidsbestanden die voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3. Deze licentie
houdt geen overdracht van rechten in voor producteigenschappen of -functies die niet 
voldoen aan ISO/IEC 11172-3 of ISO/IEC 13818-3.

Model YH-J70
Capaciteit intern geheugen YH-J70 SB/SW(20GB) / YH-J70 LB/LW(30GB) 

Capaciteit ingebouwde oplaadbare batterij 950mAh
Voltage 4.2V (Li-Ion oplaadbare batterij)

Dimensions/Weight 62 X 99.8 X 16.4mm/135g
Behuizing Plastic

Signaal/ruisverhouding 90 dB met 20 KHz LPF (gebaseerd op 1 KHz O dB)
Uitgangsvermogen oortelefoonaansluiting 20mW(Frankrijk 5mW/CH)(16Ω)

Uitvoerzenderbereik 20Hz~20KHz
Temperatuurbereik bediening -5~ +35°C (23~95°F)

FM-frequentie 87,5 tot 108,0 MHz
Signaal-ruisverhouding FM 45dB

Totale harmonische vervorming FM 1%
Gevoeligheid FM 10dB

AUDIO : MPEG1/2/2.5 Layer3(8Kbps~320Kbps, 8KHz~48KHz), WMA,
Audio ASF (48Kbps~192Kbps, 8KHz~48KHz), Ogg (Q0~Q10)

IMAGE : QCIF 160x128

Aantal speelbare bestanden Normale map : 1024 Files
Opgenomen map : 999 Files

Ondersteunde bestandsindelingen

N
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Specificaties

Dit merkteken op het product of het bijbehorende informatiemateriaal duidt erop
dat het niet met ander huishoudelijk afval verwijderd moet worden aan het
einde van zijn gebruiksduur. Om mogelijke schade aan het milieu of de
menselijke gezondheid door ongecontroleerde afvalverwijdering te voorkomen,
moet u dit product van andere soorten afval scheiden en op een verantwoorde
manier recyclen, zodat het duurzame hergebruik van materiaalbronnen wordt
bevorderd. Huishoudelijke gebruikers moeten contact opnemen met de winkel
waar ze dit product hebben gekocht of met de gemeente waar ze wonen om te
vernemen waar en hoe ze dit product milieuvriendelijk kunnen laten recyclen.
Zakelijke gebruikers moeten contact opnemen met hun leverancier en de
algemene voorwaarden van de koopovereenkomsten nalezen. Dit product moet
niet worden gemengd met ander bedrijfsafval voor verwijdering.


